ADOBE CAMERA RAW SHORTCUTS
JULIEANNE KOST | JULY, 2018

01. General Interface
• Tap F to toggle Full Screen Mode.
• When using keyboard shortcuts to select a tool, (C to access the Crop tool for example), tapping it again returns to the previously selected tool.

02. The Zoom Tool
• Tap Z to select the Zoom tool.
• Click in the image area to zoom in. Option -click (Mac) | Alt -click (Win) to zoom out.
• Click -drag left/right to zoom out/in with the Zoom tool.
• Command + “+” (plus) (Mac) | Control + “+” (plus) (Win) zooms in.
• Command + “-” (minus) (Mac) | Control + “-” (minus) (Win) zooms out.
• Double click the Zoom tool to view the image at 100% .
• Option + Command + “0” (Mac) | Alt + Control + “0” (Win) will also set the view to 100%.
• Command + 0 (Mac) | Control + 0 (Win) will fit the image within the preview area (Fit In View).
• With most other tools selected:
--Press and hold Option (Mac) | Alt (Win) to temporarily activate the Zoom Out tool.
--Press and hold Command (Mac) | Control (Win) to temporarily activate to the Zoom In tool.
• For quick navigation to a specif area, use Birds Eye View.
--Press and hold the H key.
--Click-and-hold the mouse down in the image area . The image zooms in (or not - based on the zoom level) and a rectangle appears.
--With the mouse still held down, reposition the rectangle over the area that you want to zoom to.
--Release the mouse. The image zooms in to the rectangular area. If you start in Fit In View mode or smaller, the zoom rectangle will represent
100% pixel view (1:1), otherwise it will zoom to the previous zoom level.
--Release the H key (the originally selected tool remains unchanged).
--Note: Birds Eye View is only available when GPU is enabled in the Camera Raw Preferences > Performance > Use Graphics Processor.

03. The Hand Tool
• Tap the H key to select the Hand tool.
• Double click the Hand tool to quickly zoom to Fit in View.
• With most other tools selected, press the Spacebar to temporarily access the Hand tool.

04. Navigating Through a Document Screen By Screen
• Tap the Home key to move to the top-left corner of the image. Tap the End key to move to the bottom-right corner of the image.
• Tap the Page-down key to move down one full screen. When you reach the bottom of the image, tapping the Page-down key again takes
you to the top and to the right by one full screen. Tapping the Page-up key does the same thing, but in the opposite direction.
--Note, on a laptop, use the function key and the let/right arrows to move to the top left and bottom right (Home/End) and the up/down arrows
to naviage screen by screen (Page Up/Down).

05. White Balance Tool
• Tap the I key to select the White Balance tool.
• With most other tools selected, press and hold the Shift key to temporarily activate the White Balance tool.
• The White Balance Tool’s sample area is dependent on zoom level (zoom in to sample a smaller area).
• Double click the Eyedropper tool to reset the White balance to “As Shot”.
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06. Color Sampler Tool
• Tap the S key to select the Color Sampler tool.
• Click in the image area to add a maximum of 9 Color Samples per image.
• Option -click (Mac) | Alt -click (Win) on a color sample to delete it (the icon changes to a pair of scissors).
• Click Clear Samples (next to the color readouts) to remove all Color Samplers at once.
• With the Color Sampler tool selected, press and hold the Shift key to temporarily access the White Balance tool.
• To change the Color Readouts to LAB color mode, Control click (MAC) | Right -click (Win) in the Histogram and choose Show Lab Color Readouts.

07. Targeted Adjustment Tool
• Tap the T key to select the last used Targeted Adjustment Tool (TAT).
• Option + Command + Shift + T (Mac) | Alt + Control (Win) Shift + T selects the Parametric Curve.
• Option + Command + Shift + H (Mac) | Alt + Control Shift + H (Win) selects the Hue.
• Option + Command + Shift + S (Mac) | Alt + Control Shift + S (Win) selects the Saturation.
• Option + Command + Shift + L (Mac) | Alt + Control Shift + L (Win) selects the Luminance.
• Option + Command + Shift + G (Mac) | Alt + Control Shift + G (Win) Black and White Mix.
--Note: the image Treatment option in the Basic panel must be set to Black & White to select the Black and White Mix.

08. Crop and Straighten Tools
• Tap the C key to select the Crop tool.
• Tap the A key to select the Straighten tool. Double click the Straighten tool to automatically straighten the image (this works best with
images that have a strong horizontal line).
• With the Crop tool selected, hold the Command (Mac) | Control (Win) to temporarily activate the Straighten tool.
• Shift -drag the crop handles to constrain proportions.
• Option -drag (Mac) | Alt -drag (Win) the crop handles to transform the crop from the center.
• Position the cursor outside of the crop marquee (the icon will change to the double headed arrow), and drag to rotate the Crop marquee.
• Choose another tool, double-click within the crop marquee, or tap Return (Mac) | Enter (Win) to apply the crop.
• Tap Escape to remove the crop (or resets it to start of editing session of current image).
• In order to set an aspect ratio for the Crop tool, click and hold the Crop tool icon. Choose from the list or, select Custom and enter values.
• Tap X when using the Crop or Straighten Tool to flip the crop aspect ratio (landscape to portrait, portrait to landscape).
• The Crop tool is solely responsible for defining the aspect ratio of the crop. Use Save Image and Workflow Options to determine the image size.
--For example, in order to create an image that is 8 x 10 inches at 300 ppi, click and hold the Crop tool to select 4 to 5 from the list of aspect ratios
and drag the crop in the image as desired. Then, when using Save Image or Workflow Options, check Image Sizing, select Short Size from the
drop down menu and enter 8 inches and a resolution 300 ppi.
• To display a preview of the rule of thirds, click and hold the Crop tool icon and enable Show Overlay.
• Command -click (Mac) | Right -click (Win) within the crop marquee to access many of the Crop options via the context sensitive menu.

09. Transform Tool
• Shift + T selects the Transform tool.
• For best results, in the Lens Corrections panel, enable Remove Chromatic Aberration and Enable Lens Profile Corrections before applying
Upright Transforms and Guided Upright.
• The Transform tool will generally work better on raw files because it can take advantage of more reliable metadata (e.g., focal length).
• Shift + G toggles the Grid overlay.
• Shift + L toggles the loupe on/off. Note: displaying the loupe requires GPU support.
• Option -drag (Mac) | Alt -drag (Win) displays a loupe and activates precision cursors (enabling a slower drag for accuracy without having to
zoom into the image).
• Tap the V key to toggle the Guided Upright tool’s overlay (the guides).
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• Additional refinement can be made with the manual perspective adjustments in the Transform panel:
--The Aspect slider (in the Transform panel) can help remove vertical and horizontal distortions if an image is overly squished or stretched.
--When using the Transform tool to correct perspective, the resulting image is often cropped in order to avoid displaying blank areas around the
edges. To help retain necessary information from the original image that would otherwise be cropped use the Scale, X Offset, or Y Offset slider in
the Transform panel to reposition the image within the canvas. Command + Option | Control + Alt -drag to reposition the image in the preview
area via the Offset X/Y sliders. Add the Shift key to constrain to horizontal/vertical directions.
--Rotated crops and manual perspective corrections on existing images will usually interfere with Upright transformations. For this reason, selecting
one of the Upright modes (with the transform tool) will reset the crop and manual perspective adjustments (Horizontal, Vertical, Rotate, Scale,
and Aspect controls). Resetting the crop has the benefit of showing the user the maximum amount of image area remaining after an Upright
adjustment. To preserve these settings, Option + (Mac) | Alt + (Win) -click when choosing an Upright transformation.

10. Spot Removal Tool
• Tap the B key to select the Spot Removal tool.
• Tap the V key to toggle the visibility of the spot overlays.
• Shift -drag constrains the brush spot to a horizontal or vertical stroke.
• Shift -click connects the selected spot with the new spot via a straight brush stroke.
• Command -drag (Mac) | Control -drag (Win) will create a circle spot and allow you to drag to define the source.
• Tap the Forward Slash key (/) to select new source for existing circle or brush spot.
• Press Delete to delete a selected spot.
• Option -click (Mac) | Alt -click (Win) on a spot to delete it (the cursor will change to a pair of scissors).
• Option -drag (Mac) | Alt -drag (Win) in the image area over multiple spots to batch-delete.
• Tap the “Y” key to toggle on/off Visualize spots.
• Tap the left and right brackets to decrease/increase brush size. Add the Shift key to decrease/increase the feather.
• Use the Opacity slider to decrease the opacity of a retouched spot (to minimize a distracting element instead of removing it).

11. Red Eye Removal Tool
• Tap the E key to select the Red Eye Removal tool.
• The Red Eye tool can also correct bright pupils in animals. For Type, select Pet Eye and use the Pupil slider and Catchlight options as desired.

12. Shared Shortcuts Between the Adjustment Brush, Graduated Filter, and Radial Filter
• Tap V to toggle the visibility of the tool’s interface.
• Hover the cursor over the pin to display the mask overlay or, tap the Y key to toggle the visibility of the mask overlay.
--Click the color swatch to the right of the Mask option to choose a different color to display as the mask overlay.
• Command + Option + R (Mac) | Control + Alt + R (Win) will reset the options for the tools. This shortcut will work, regardless of whether you
have a local correction selected or not. If you don’t have an adjustment selected, the shortcut will simply reset the sliders to zero for the next
correction that you create.
• Tap the N key to commit to the adjustment.
• Press the Delete key to delete the selected adjustment or, Option -click (Mac) | Alt -click (Win) an adjustment’s pin to delete it.
• Command + Option -drag (Mac) | Control + Alt -drag (Win) the pin to duplicate the adjustment.
• Right -click on the adjustment’s pin to select tool specific options form the context sensitive menu (i.e. Duplicate, Delete, Fill Image, Reset
Local Settings, Clear Brush Modifications).
When painting using the Adjustment Brush, and/or the Graduated and Radial Filter’s modification brush:
• Option+ “[“ or “]” (Mac) | Alt + “[“ or “]” (Win) decreases/increases brush size. Add the Shift key to decreases/increases Feather (edge softness).
• Tap “+ “ (plus) or “-” (minus) to increase/decrease Flow.
--The Flow sets the speed at which the brush applies an adjustment. Lowering the Flow amount enables a slower build up of an effect and can
reduce the number of individual pins needed to modify an image as one can apply different amounts of the same adjustment in different areas
without having to create a new pin for each different amount.
--Density caps the amount of the adjustment that can be applied (even with multiple strokes)
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• Control -drag left/right to decrease/increase the brush size. Control + Shift -drag left/right to decrease/increase the Feather ((edge softness).
• Option (Mac) | Alt (Win) toggles the Brush/Eraser for the Adjustment Brush and the Add To/Subtract From for the Filter’s modification brush.
• To keep the brush and eraser size the same, click the fly-out menu and disable “Separate Eraser Size” from the menu.
• Camera Raw supports pressure-sensitive devices such as Wacom and Microsoft Surface Pro tablets. Pressure applied to the pen affects the
Flow. Turning the pen over and using the “eraser” side automatically switches the brush to the eraser mode (if your pen supports this feature).

13. Adjustment Brush
• Tap the K key to select the Adjustment Brush.
• Shift -drag constrains the Adjustment Brush to a straight line.
• Tap the M key to toggle on/off Auto Mask (Auto Mask automatically detect edges based on contrast and color to help selectively apply
adjustments to a desired area).

14. Graduated Filter
• Tap the G key to select the Graduated Filter.
• Shift -drag with the Graduated filter constrains it to 15 degree angles.
• The length of the gradient determines how quickly the adjustment fades. To adjust the Gradient:
--Drag the red or green dot to adjust the length of the fade range.
--Drag the black dashed line to reposition the Graduated Filter.
--Drag the red or green dashed lines to rotate it.
• Shift + K toggles between editing the Graduated filter and the Brush modification mode (used to edit the mask).

15. Radial Filter
• Tap the J key to select the Radial Filter.
• Shift -drag constrains the Radial Filter to a circle.
• With a Radial Filter selected, press the X key to toggle the effect direction from outside to inside.
• While dragging one of the four handles of an existing Radial Filter to resize it, press the Shift key to preserve the aspect ratio of the ellipse.
• While dragging the boundary of an existing Radial Filter to rotate it, press the Shift key to snap the rotation to 15-degree increments.
• While dragging to create a new Radial Filter, press and hold the Space bar to reposition the ellipse; release the Space bar to resume defining
the shape of the new Radial Filter.
• While dragging inside of an existing Radial Filter to move it, press the Shift key to constrain the movement to the horizontal or vertical direction.
• You can drag a Radial Filter beyond the image area.
• Double-click in the image area to set the bounding box of the Radial filter to “Fill” the image bounds.
• Double-click on existing Radial Filter to expand the bounding box of the Radial Filter to “Fill” the image bounds.
• Shift + K toggles between editing the Graduated filter and the Brush modification mode (used to edit the mask).

16. Camera Raw Preferences
• Command + K (Mac) | Control + K (Win) will launch the Camera Raw Preferences.
• When moving back and fourth between multiple images, it can be a performance advantage to increase the Camera Raw Cache when
working with raw files. The larger the cache, the greater the number of images Camera Raw can hold onto for quick access - making it faster
to load recently viewed images. If you are simply moving from one image to the next (without returning to the previously viewed images),
then you may not see a benefit from increasing the Camera Raw Cache.

17. Rotating and Flipping Images
• Tap the R key to rotate an image clockwise or use Command + “[“ (Mac) | Control + “[“ (Win)
• Tap the L key to rotate counter clockwise or use Command + “]” (Mac) | Control + “]” (Win).
• Option (Mac) | Alt (Win) toggles the Rotate icons to Flip Horizontal and Flip Vertical.
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18. The Histogram
• Control -click (Mac) | Right -click (Win) in the Histogram to enable Lab color readouts.
• Click -drag on the interactive Histogram to adjust the Blacks, Shadows, Exposure, Highlights, and Whites slider adjustments in the Basic tab.
• Tap the U key (underexposed) to preview areas in an image that are clipped to pure black by displaying a blue overlay.
• Tap the O key (overexposed) to preview areas in an image that are clipped to pure white by displaying a red overlay.
• The Clipping Warning triangles turn different colors to show that different channels are being clipped.
--If no values are clipped, the triangles are black.
--If values are clipped in the red channel the triangles are red.
-- If values are clipped in the green channel the triangles are green.
--If values are clipped in the blue channel the triangles are blue.
--If values are clipped in the red + green channel the triangles are yellow.
--If values are clipped in the red + blue channel the triangles are magenta.
--If values are clipped in the green + blue channel the triangles are cyan.
--If values are clipped in all channels, the triangles are white.

19. Resetting settings
• Command + Z (Mac) | Control + Z (Win) will toggles (Undo/Redo) the last change made.
• Command + Option + Z (Mac) | Control + Alt + Z (Win) goes back in time (Multiple Undo).
• Command + Shift + Z (Mac) | Control + Shift + Z (Win) goes forward in time (Multiple Redo).
• Double clicking the “tick” on the slider will reset the slider.
• Click in any text entry area to enter specific numeric values. Tap the Tab key to move to the next text entry. With text entry highlighted, use
the up/down arrow keys to modify existing values. Add the Shift key to move in larger increments.
• Holding the Option (Mac) | Alt (Win) key toggles the “Cancel” button to “Reset”. Clicking Reset reverts the image settings to the beginning of
the session (this may or may not be the camera defaults if it’s not the first time the image is opened in Camera Raw).
• To reset an images (remove all changes), use the fly-out menu on the panels and choose Camera Raw Defaults.

20. Displaying Panels
• Option + Command + 1, 2, 3-9 (Mac) | Alt + Control + 1, 2, 3-9 (Win) displays the corresponding panel (Basic, Tone Curve, Detail etc.).
--Note: Mac users must disable Universal Access in the OS in order to display the Calibration panel (Option + Command + 8).

21. The Basic Panel
• White Balance
--Camera Raw displays a list of “preset” White Balance settings (Auto, Daylight, Cloudy, Tungsten etc.). This list differs slightly from camera to
camera. When working with JPEG files, As Shot, Auto, and Custom are the only menu options.
--The White Balance values displayed for RAW and JPEG files will differ. The Temperature and Tint sliders will display numeric values from -100
to +100 for JPEG files as opposed to Temperature (2000-50000) and Tint (-150 - +150) values for RAW files.
--Shift -double click the Temperature or Tint adjustment sliders to apply Auto Temperature and Auto Tint controls separately from one another.
• Toning (Exposure, Contrast, Highlights, Shadows, Blacks, Whites)
--Command + U | Control + U (Win) applies Auto Tone adjustments to an image.
--Shift -double click an individual slider (Exposure, Highlights, Shadows, Whites, or Blacks ) to apply Auto settings to just that slider.
--Option -drag (Mac) | Alt -drag (Win) the Exposure, Highlights, Shadows, Whites, or Blacks sliders to preview clipped values in an image on a
per channel basis.
• Presence adjustments (Clarity, Dehaze, Vibrance, Saturation)
--Clarity is biased to increases/decreases midtone edge contrast (not full-range or overall contrast).
--The Dehaze technology is based on a physical model of how light is transmitted, estimating the amount of light that is lost due to absorption
and scattering through the atmosphere. For the best results, set the white balance for the image before using Dehaze. Move the slider to the
right to easily remove the haze from the original scene. Move the slider to the left to add a creative haze effect. When moving the slider, there is
very little change in the highlight area of the image, while the shadows and lower portion of the histogram is clearly being changed. If you are
concerned that the darker values in the image are being clipped to pure black, Option (Mac) | Alt (Win) -drag the slider to see the black point
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clipping visualization. When you see black areas appear in the image, you know that you’re starting to clip areas to pure black.
--Vibrance is a relative and biased slider - it increases/decreases the amount of color in an image based on how much color there was to begin
with and, it adjusts orange, red, and yellow values less than other colors. It can be very useful when increasing saturation in blue sky, green grass
etc., while avoiding most shifts in skin-tones.
--Saturation is an absolute adjustment. Moving the slider to -100 will remove all color from an image, +100 will fully saturate colors in an image.

22. The Tone Curve Panel
• There are two curves in the Tone Curve panel: the Parametric and the Point curve. On the Parametric curve:
--Drag the Highlights, Lights, Darks, and Shadows sliders on the Parametric curve to lighten/darken the image.
--To change the tonal range affected of any of these sliders, reposition the triangles directly under the curve.
--To make on-screen adjustments, select the Targeted Adjustment tool (Command + Option + Shift + T (Mac) | Control + Alt + Shift + T (Win)),
and click -drag up/down in the image preview to lighten/darken the value clicked upon.
• On the Point Curve:
--Command -click (Mac) | Alt -click (Win) in the image area to set a point on the curve.
--Drag to reposition the point in the Tone Curve panel or use the up, down, left, right arrow keys to precisely reposition the point as necessary.
--A maximum of 16 points can be added to each curve to make color corrections and/or add creative effects.
--Adjust the composite image or individual red, green, and blue channels (accessed via the Channel drop-down menu).
--Control + Tab moves from one point to the next along the curve (including the black and white points).
--Shift -click to select multiple points in the Curves panel at once.
--Tap delete to do delete individual points on the Point Cure, or click -drag the point off the curve.
--To reset the Point Curve, chose Linear from the Curve drop-down menu.

23. The Detail Panel
• Zoom into 100% to accurately view the effects of Sharpening and Noise Reduction.
• When sharpening, the amount is the amount of contrast added to edges and the Radius determines how many pixels along the edge are
effected. The Detail and Masking sliders suppress sharpening in the lower contrast areas of an image. As a rule of thumb, the Detail slider is
better at suppressing sharpening in high-frequency images such as landscapes while the Masking slider is better when working with portraits.
• Option -drag (Mac) | Alt -drag (Win) the Radius, Detail and Masking sliders (as well as the Luminance sliders in Noise Reduction), to display
a greyscale preview of the slider’s effect. Previewing the edges of the masks (the Detail and Masking sliders), is helpful in determining which
option is best for the image that you’re working on.
• Luminance and Color Noise reduction are controlled using separate sliders. Typically images can handle larger reductions of Color Noise than
Luminance Noise without detrimental effects to the image. To help reduce (or even remove) low-frequency color mottling (small clumps of
magenta or green areas in an image for example), increase the Smoothness slider in Noise Reduction.

24. HSL Adjustments Panel
• Use the tabs to select Hue, Saturation, and Luminance to make edits either by using the sliders, or by selecting the desired Targeted Adjustment
tool and click-dragging up/down (or left/right) in the image area to increase/decease the adjustment.
• Use these shortcuts to access a the different Targeted Adjustment Tools:
--Command + Option + Shift + H (Mac) | Control + Alt + Shift + H (Win) selects Hue.
--Command + Option + Shift + S (Mac) | Control + Alt + Shift + S (Win) selects Saturation.
--Command + Option + Shift + L (Mac) | Control + Alt + Shift + L (Win) selects Luminance.
• If an image’s Treatment is set to Black & White (in the Basic panel), the HSL Adjustments panel changes to Black & White Mix. Command + Option
+ Shift + G (Mac) | Control + Alt + Shift + G (Win) selects the Black and White Mix Targeted Adjustment tool.
• When converting to B/W, use the Camera Raw preferences to set the Default Image Settings to “Apply auto mix when converting to black &
white” if desired.

25. Split Tone Panel
• Option -drag (Mac) | Alt -drag (Win) either Hue slider in the Split Toning panel to temporarily view the colors at 100% saturation (making it
easier to choose the desired hue). Then, release the keyboard modifier and use the Saturation slider to dial in the desired amount of color.
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• Option -drag (Mac) | Alt -drag (Win) the Balance slider in the Split Toning panel to temporarily preview the Split Tone colors at 100% saturation
(making it easier to see where the colors split in the image).

26. Lens Correction Panel
• To achieve even vignette when cropping an image, apply Enable Profile Correction in the Lens Correction panel to remove vignetting caused
by the lens and then, in the Effects panel, use the Post-Crop Vignetting options to apply vignetting based on the cropped image.
• To create your own lens profiles (for unique lens/camera combinations, use the free Adobe Lens Profile Creator Tool. All of the information
that you need to know is here: https://helpx.adobe.com/photoshop/digital-negative.html

27. Effects Panel
• There are three Post Crop Vignetting Styles:
--Highlight Priority - enables highlight recovery but can lead to color shifts in darkened areas of a photo. It is suitable for photos with bright image
areas such as clipped specular highlights and behaves more like a traditional exposure burn.
--Color Priority - minimizes color shifts in darkened areas of a photo but cannot perform highlight recovery. This style also behaves more like a
traditional exposure burn.
--Paint Overlay - similar to an overlay of black or white paint. Although this style might look fine on screen, I wold recommend using the other
two styles for any printed work.
• Both Highlight Priority and Color Priority styles include a Highlights slider. Increase the slider’s value to reintroduce contrast in the highlights
(and avoid muddy areas in images). The sliders effect is most noticeable if the vignetting is applied over bright areas such as highlights in a sky.
• The Grain effect deliberately varies from image to image to facilitate editing time-lapse and video frame sequences.

28. Presets Panel
• Control -click (Mac) | Right -click Win) on a custom preset to access a wide variety of options including: Preset Info, Add to Favorites, Hide
Presets, Move Preset, Rename Preset, Delete Preset, Hide/Rename/Delete Preset Set, Manage Presets, Reset Favorite and Hidden Presets, and
Import Profiles & Presets.
• Presets are stored by default here:
--Windows: Win (user)/Application Data/Adobe/Camera Raw/Settings.
--Mac: Mac (user)/Library/Application Support/Adobe/Camera Raw/Settings. Note: on Mac, hold the Option key down while selecting the “Go”
menu in the Finder to reveal the Library folder.
• To apply a preset to an image in Bridge, first, in the Preset panel, click the star icon to tag the preset as a Favorite. Then, in Bridge, select the
desired file(s) and choose Edit > Develop Settings > (your preset). Or, Control -click (Mac) | right -click (Win) and use the context sensitive
menus to select Develop Settings > (your preset).
• The quickly clear Camera Raw Setting from images in Bridge, choose Edit > Develop Settings >Clear Settings or, Control -click (Mac) | right
-click (Win) on desired file(s) and use the context sensitive menus to choose Develop Settings > Clear Settings.

29. Snapshots Panel
• One of the benefits of saving Snapshots is that they’re available when the file is opened as a Smart Object in Photoshop. This makes it easy
to move back and fourth between different sets of processing instructions when designing a layout or making a multi-image composite.

30. Before and After Previews options
• Click the Cycle between Before/After Views button to cycle through left/right and top/bottom side-by-side and split-view modes.
--Tap Q to cycle through the Before/After Views .
--Click-and-hold the Cycle between Before/After Views button to quickly select a specific Preview mode from the menu.
-- Click-and-hold the Cycle between Before/After Views button to access and customize Preview Preferences.
• Click the Swap Before/After settings button to swap settings.
--Tap the P key to swap Before/After settings for the primary selected image only.
--Tap Shift + P to swap Before/After settings for all selected images.
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• Click the Copy button to copy the After settings to the Before settings (useful for establishing a temporary “checkpoint” for an editing session).
--Option + P (Mac) | Alt + P (Win) copies After settings to the Before settings for the primary selected image only.
--Option + Shift + P (Mac) | Alt + Shift + P (Win) copies After settings to the Before settings for all selected images.
• To toggle the preview for only the active panel, click the Per-Panel Preview icon (This temporarily resets the settings in the selected panel
to their defaults). Click the icon again to reset the options to the previous settings.
--Command + Option + P (Mac) | Control + Alt + P (Win) toggles the Per-Panel Preview.

31. Adding Ratings and Labels in Camera Raw
• The following shortcuts are available when multiple images are open in Camera Raw.
--Command + 1, 2, 3, 4, 5 (Mac) | Control + 1, 2, 3, 4, 5 (Win) will add star ratings.
--Command + 6, 7, 8, 9 (Mac) | Control + 6, 7, 8, 9 (Win) will add color labels.
--Command + “.” or “,” (Mac) | Control + “.” or “,” (Win) will increase/decrease star ratings.

32. Save Image Options
• Use the Save options to quickly save derivatives of your edited images. Save Image options include Location, File Naming, Format, Color
Space, Image Sizing, and Output Sharpening options.
• Option (Mac) | Alt (Win) key toggles “Save Image...” to “Save Image” (with out the ellipse) which saves the image bypassing the Save Options
dialog (it automatically uses the last settings).
• Renaming files - it might help to append the current filename (LR = low res, FS = Flat Sharpened etc.)
• Color Space - when saving files as JPEG to distribute to clients or to use in social media, I use sRGB as my color space. When saving an image
to be edited, I use AdobeRGB and/or ProPhoto for greater color latitude when editing.
• When resizing images, the Long and Short side options can be useful when saving files with different orientations.
• Output sharpening is based on a number of factors including output device, size of original, size of output and more. Choose Screen, Glossy
or Matte paper and dial in the amount according to the content of the image and personal preference.
• Use the Preset menu to save presets for frequently used settings.

33. Workflow Options
• Set the workflow options before choosing Open Image(s). Workflow options include Color Space, Image Sizing, Output Sharpening, and
Open as Smart Objects options.
• Use the Presets menu to save Workflow options for frequently used settings.
--After creating custom workflow presets, Control -click (Mac) | right -click (Win) the workflow hyperlink to quickly switch between them.
• Option (Mac) | Alt (Win) toggles “Open Image” changes to “Open Copy” which opens a copy of the image (useful for opening multiple copies
of the same file processed in different ways).

34. Open as Smart Objects
• Hold the Shift key to toggle “Open Image” to “Open Object” in order to open an image in Photoshop as a Smart Object without having to
edit the Workflow options. If the Workflow settings are set to Open as Smart Object, the Shift key will toggle to Open Image.

35. Syncing Edits Across Images
• To make changes to more then one image at a time, select them in the filmstrip.
• With multiple images selected, Option -click (Mac) | Alt -click (Win) the thumbnail of a selected image to make it the active image while
keeping all of the other images selected.
• Command + A (Mac) | Control + A (Win) selects all images.
• Command +Option + A (Mac) | Control + Alt + A (Win) selects all rated images.
• With multiple images selected, Option + S (Mac) | Alt + S (Win) displays the Synchronize dialog in order to choose what settings to synchronize.
• With multiple images selected, moving a slider will set the same value for each image. However, some settings will be applied based on the
image content including: Lens Correction (Remove Chromatic Aberration and Enable Profile Corrections) Auto Upright Modes, Auto Tone,
and Auto Black and White Mix. Note: to apply the same numeric settings across all selected images, apply the settings the first image, then
choose Sync from the filmstrip’s drop-down menu and choose the items to be synchronized (White Balance, Exposure, Contrast, etc.).
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36. Setting New Camera Raw Defaults
• In order to change the default rendering of your raw files, open an image in Camera Raw and choose Camera Raw Defaults from the flyout
menu (next to the panels) to reset the image. Then, make the changes that you want to be your default settings (a different profile for example
or automatically applying Lens Profiles and Removing Chromatic Aberration). Return to the fly-out menu and choose “Save New Camera Raw
Defaults”. From that point on, every time you open raw file from that camera the new default settings will be applied.
• Use the Camera Raw Preferences, to make Camera Raw Defaults specific to Camera Serial Number and ISO setting.

37. Using Camera Raw without launching Photoshop
• For most people, the fact that Camera Raw is a plug in that works in both Bridge and Photoshop is completely transparent. The most common
workflow is to find the desired image in Bridge, double click to open it in Camera Raw and start making edits. When finished editing, clicking
the Done button will close Camera Raw and leave you in Photoshop. If, instead, after selecting images in Bridge, you choose File > Open in
Camera Raw, click the Open in Camera Raw icon, or Command+ R (Mac) | Control + R (Win), Bridge launches the Camera Raw plug-in so that it
runs within Bridge (not Photoshop). The advantage to this workflow is that you can make edits using Camera Raw without having Photoshop
open and, when you are finished making edits in Camera Raw, clicking the “Done” button, returns to Bridge.

38. Bypass the Camera Raw Dialog
• Shift-double clicking on a RAW image in the Bridge will bypass the Camera Raw dialog, applying either settings that have been saved with
the file, or if there are no setting applied, opening the file with the camera defaults into Photoshop.

39. Merge to HDR
• Not all adjustments made to individual images carry over when selecting Merge to HDR in Camera Raw. For example, if you have made
local adjustments on individual exposures, those adjustments will not be applied to the merged file. Because of this, I would suggest that
you don’t spend a great deal of time making adjustments to each of the individual exposures but instead, merge the images and then make
adjustments to the resulting, HDR image. The settings that are NOT copied over from individual exposures to the merged file are:
--Crop and Upright transformations
--The primary tone settings in the Basic panel (Exposure, Contrast, Highlights, Shadows, Whites, and Blacks) and the Tone Curve
--Local Corrections (The Adjustment Brush, Graduated and Radial filters, Red Eye, and Spot Healing)
--Process Version (if set to anything other than the most recent)
• If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Split Toning
adjustments) , make sure that the exposure with the adjustments is the active or “most selected” image.
• Tap the A key to toggle the Align Images feature.
• Tap the T key to toggle Auto Tone.
• Tap the Y key to show the Deghost Shadow Overlay.
• HDR merging requires exposure metadata. If aperture and ISO information is available, then it is used as well. Camera Raw will show an error
if you try to merge photos of different sizes, focal lengths, etc.
• Option + Shift + M (Mac) | Alt + Shift + M (Win) will run Photo Merge > HDR based on the last used Merge settings (bypassing the dialog).
• By default Camera Raw appends the resulting image’s file name with -HDR.
• The resulting (merged) HDR files will always default to the current Process Version.

40. Merge to Panoramas
• If you have made adjustments to the individual images prior to choosing Photo Merge > Panorama, not all of them carry over to the merged
file. For example, if you have made local adjustments on individual exposures, those adjustments will not be applied to the merged file! Because
of this, I would suggest that you don’t spend a great deal of time making adjustments to each of the individual exposures but, instead, merge
the images and then make adjustments to the resulting Panorama image. The settings that are NOT copied over from individual exposures
to the merged panorama are:
--Lens Corrections (with the exception of Defringe settings), Crop and Upright transformations
--Local Corrections (The Adjustment Brush, Graduated and Radial filters, Red Eye, and Spot Healing)
• If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Split Toning
adjustments) , make sure that the exposure with the adjustments is active or “most selected” image.
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• Command + Shift + M (Mac) | Control + Shift + m (Win) will run Merge to Panorama based on the last used settings (bypassing the dialog).
• By default Camera Raw appends resulting image’s file name with -Pano.
• Post-merge, lens profiles don’t make any sense to apply to panoramas, so the feature is disabled.
• To quickly select different projection options, tap “1” to select Spherical, tap “2” to select Perspective, and tap “3” to select Cylindrical.
• Tap the C key to enable Auto Crop.
• Use the Boundary Warp slider to adaptively stretch or reshape the edges of a stitched panorama to fill the rectangle boundary.
• There is a size limit of 65,000 pixels on the long side of a file or, 512 MP - whichever comes first.

41. Soft Proofing
• Camera Raw includes the ability to select RGB, CMYK and LAB ICC profiles to soft proof images. To select a profile, click the Workflow Options
hyperlink at the bottom of the Camera Raw window and, in the Color Space section, choose the desired profile from the pop-down menu.
Once a profile is selected, Camera Raw displays a “soft proof” of that image. In addition you have the ability to choose either Perceptual or
Relative as your rendering Intent and can choose whether or not to Simulate Paper and Ink. There is not an option for Black Point Compensation because it is always enabled in Camera Raw.
• Grayscale color profiles will only appear in the Space popup when processing a monochrome image or when converting a color image to
grayscale.
• When using a Lab or CMYK color space, the histogram and color readouts will change accordingly.
• For accurate results, monitor calibration is a must! In addition, there may very well be some colors that simply aren’t reproducible on a
monitor that can be printed and vice versa.

Copyright 2018 Julieanne Kost All Rights Reserved.

10

